Learning FirstClass

A. Setting up the program '®O "  Service Setup
! ,
« Install the program and the setup {,_‘I Connect via: | Local Network.FCP %] ( Configure... )
window will open. UserID: crigsby
e Fill in the server information Password:

mail.ccsd.k12.wy.us
* The user id may be filled in also.
*  Click Save.

1 As guest

Login:

’:‘ Automatically Retry login: 0 :1 times

Retry delay: 0 :1 seconds

Fill in if service is accessible via the network

Do not save your password in the

Server: mail.ccsd.k12.wy.us
password box. Ifitis saved there,
anyone can gain access to your #»‘, Fill in if service is accessible via modem or ISDN
email at any time. Phone #:
E} Security settings
Encryption: | Default [
Server ID: |

[ FirstClass secure authentication only

[ Refuse upgrades to the FirstClass client software

|

Notifier [ Notify me of new mail when offline

Notifier password:

Clears all nonconnection resources from your settings file Flush Cache

(Cancel \/ Save \

B. Logging In

1 &0 FirstClass Login

*  Click on the icon to open FirstClass

* Enter the user id and password if the FI RST CIASS’

user id is not already there.

* Click Login. User ID: 4

4




C. First Class Desktop

* The red flag on the Mailbox
indicates a message that has
not been read yet.

eNOo Desktop : Campbell County

l§ =
Go Back Go Forward Find Permissions | Who's Online

,_
T T T S

e The Contacts file will hold ] Desktop 1 File 27 Folders Campbell County : Cynthia Rigsby
individual email addresses
and mail lists can also be ) =]
created with several email %
addresses in it . , S—
T Mailbox Calendar Lyla's Calendar
* Mail lists created by the
district and CCSD Forms i R
created by the district !
?an_n(,)t be changed by an | | Tech Conference  CCSD Forms Staff De;/:anference
individual. Only the it
o 1 _—
district can change these. > y— A ¢ "
* Conference folder for your - &= ’
school may be on the mail i Mail Lists Documents Contacts
desktop.
* CCSD Forms will need to 13-
be updated to be viewed
properly. LLC Tech Calendar
[ = >
: ‘ 1 Item selected. 8
D. File
New > I
* New — create new items in FirstClass Open > k
* Save As — Save a message to a folder on your computer Close #EW
* Import — import items to the FirstClass desktop Upload 9T
* Undelete — undeletes deleted items (must first pick show Dp | q ;
deleted items under View) " i
* Print Layout — formats layout of items that are printed Import > >
* Print — use this to print a message, calendar item, etc. Export...
Save As...
I
Get Info... 3l °
Print Layout
Print... #P .
/




E. Edit

Undo Typing ®7 | Mac OSX
l{evert to Saved .
: X | * Check Spelling lets the user check the spelling in a message before it is
Paste 8v I sent

Slectih A | * The rest of the Edit menu is like any edit menu from other programs.

Paste Plain Text |
Paste Special... a8V . . .
- er ‘ * The preferences for FirstClass are under the menu item FirstClass
Qufck Search osek |
Insert > |
Table >
Make Link...
st Markers |
_ z Preferences
Check Spelling... (3L |
f e0n Preferences B B
' General I Calendar I Content Y Viewing I Messaging I Web I Voice Y Handheld Devices ]
General [ | Register FirstClass® as default mail client
"1 Quit on disconnect
E Use forms background
Set 3D look and background -
Image: wallpaper blue shade.jpg B
of desktop.
New mail form: [ Default '-@-]
Mailbox style : [ Default ]
Download folder: fUsers/crigsby/Library/firstclass/Download
Contacts
Contact form: [ Default 3
Map addresses using: [ Default '—3-]
( Default ) ( Apply ) ( Cancel ) ( OK )
0N Preferences b .

Calendaring [ General (“Calendar | Content | Viewing | Messaging | Web | Voice | Handheld Devices |

View Events

Week start day: Sunday q: Starts the week on this day in month view.
Work week start day: Monday q: Starts the work week on this day in the work

week and month views.

Default event start times fall within the work
day. If no free time can be found for a
particular day, the default start time is the
start of the work day.

Make changes to the setup of your calendar surtofworkday:  [8:00AM
on the deSktop Length of work day: 8 Hours

L:'Jo

" Collapse weekends in month view

[ Show week numbers Displays the week number of the year.
Colors
Workday: )v]
Evening: | |82
Weekend: lv]

( Default ) (" Apply ) ( Cancel ) OK )




Content

[ General ' Calendar '—Gnmm-‘ Viewing ' Messaging I Web I Voice I Handheld Devices ]

Set the size, style and color of font to [Textsuies | Hionight styles | spell Check | Options |

use in all messages sent out. ~Normal text
Font: I H
Set the spell check preferences. - M
Color: E
P ion text
[

[ General ' Calendar ',—mm—' Vie\qing ' Messaging ' Web ' Voice ' Handheld Devices ]
\
[ Textstyles | Highlight Styles }_sub(m_]' Options |

a Ignore quoted text S Ignore words with numbers
g Ignore URLs g Ignore words in UPPERCASE
™ Split contracted words ™ Split compound words
( Default ) ( Apply ) ( Cancel ) ( OK )
B Enable suggestions g Automatically check on send

( Default ) ( Apply ) ( Cancel ) ( OK )

Viewing
[ General T Calendar T Content }—Mng—{ Messaging T Web T Voice T Handheld Devices ]
Use this tab to specify viewing preferences in your Mailbox, messages, conferences, folders, and calendars.
Client interface: eShow newest items first
Set the view you wish to see on ) Show only unread items
your de Sktop and maﬂbox. ) Double-click in explorer tree opens a new window

Time zone: [ Default 4

(Default) ( Apply ) ( Cancel ) ( oK )




Messaging

1. Set Reply Preference to Reply Sender.
If it is set on Reply Automatic, you will
send your reply to everyone on the
original message

2. Signature — add information to be put on
each message created

3. Instant Messaging — set preferences for
private chat

4. Paging — is not available

ré 00 Preferences

e0Nn “preferences

( General T Calendar T Content T Viewing 1 Messaging T Web T Voice T Handheld Devices ]

' Mail Rules ‘ Initial Content ' Instant Messaging ' Paging ' Audio ]

io s
@ Mailbox Rules... |&* | Import Accounts...

Reply preference: | Automatic 4
 Automatically reply to
Local mail: No o Reply text:
Internet mail: [ No v

 Automatically forward

7y

Local mail: ['No v Forward to:
Internet mail: [ No )
Voice/fax mail: [ No )

Method: [ Redirect v

Junk mail handling: [ Accept %

( Default ) ( Apply ) ( Cancel ) ( OK )

[ General | Calendar | Content | Viewing [ Messaging | Web | voice | Handheld Devices |

[ Mail Rules ' Initial Content I Instant Messaging T Paging T Audio ]

Cursor placement In reply: Default ‘v
Reply tagging: [ Default v
Forward tagging: [m
ﬁ ically add sig to new

Signature text:

Cynthia Rigsby
Technology Technician
Campbell County School District

( Default ) ( Apply ) ( Cancel )( OK )

_0 @) oY - __ Preferences

[ General I Calendar ' Content ' Viewing ' Messaging Web Voice Y Handheld Devices ]

[ Mail Rules T Initial Content ] Instant Messaging ' Paging Y Audio ]
[ ) Refuse invitations
E Activate instant messaging sounds

Show presence to: | Default -y

( Default ) ( Apply ) ( Cancel ) ( OK )

F. Format Show Fonts
Font >
+ Size >
Format the text in a new message, document, address, etc. Style >
Color >
Align >
Increase Indent
Decrease Indent
Bulleted List
Format Text... #M

Format Paragraphs... {3M
Format Bullets

Format Margins...

Format Background...

Sample Current Style

Reset to Default




G. Message

* New Message — create a new message

* New Message Special — use message forms that have

already been created

| New from Conference
Directory Diagnostics
File Transfer
Image Message
Mail
Message
Phone Call
S/MIME Message

-

Collaborate

View

|

New Message
New Message Special

Reply Special

Mark as Unread
Summarize Selected

Priority
Sensitivity
Receipt

* Reply Special — automatically replies to a message with a quote,
to all that received the original message, to only the sender, to a

| Reply with Quote %'

particular conference, or to the original sender of the message. Reply All

* History — gives the history of a message but only messages
created and sent to users of FirstClass.

Reply Sender
Reply Conference
Reply Original Author

* Mark as Read — allows a message to be marked as read or unread
* Receipt — allows a message to be marked to return a receipt to the originator when a message is read,
delivered or routed

H. Collaborate

I v Connect...

Directory... 8L
Who's Online...

Navigation > |
Approve ®°
Work Offline >

Disconnect

List Connections...

Change Password...

home.fc Setup...

i Instant Message

Connect — click on to have a login screen appear

Disconnect — click on to log off

List Connections — shows how long a user has been connected
Change Password — change user password here. Put in the old
password first, then the new password and retype the new
password.

(@) (j—-e Change Password

Change Password
Uszeril:  crigsby

Old Password:

Mew Password:

Retype Password :

."'

Cancel * 7 0K




* Home.fc setup — another way to enter the setup screen covered on the first page of this handout

* Directory — a listing of all users on this FirstClass system

*  Who’s Online — a listing of users currently logged in

* Instant Message — a chat line between FirstClass users on this system that are currently logged in

1. View

* View by Icon, View by Scaled Icon, View by List — Sets the view on the window that is currently

Opep' . . . ‘ View by Icon
* Split — splits the window that is currently open | View by Scaled Icon
{ v View by List
View by Index Card L

v No Split |
Split Horizontal |
Split Vertical |

Open in Same Window

-~ b il e

* Show Deleted Items — highlight this and find the item that
was deleted. Highlight the item and it can be undeleted by | ¢
clicking on undelete under the File menu. | Split > |

* Change View Properties — set how to sort items in the Filter >
mailbox, display of icons, lists, background of window. Show Deleted Items
The window must be opened to apply to that particular Change View Properties...
window except in sorting. ‘

Content View > |
L
Ma— . . - — l i
O 060 View Properties mage >
- — — - "
’ Sorting ' Display ' lcons ' Background | Zoom Window ®=
Display format: lzon n-?] i Toolbars > ::
Sort on: Last Modified 3] § - ring All to Front
_ Default ' ) i
 Reverse sort — ailbox : Campbell County
y — )
Group itemns on: Sub ject E] p Apply . L SktOp g Campbell County ]
: Caollapse all groups ( Cancel b l
oK ) * Toolbars — allows the user to
— customize the toolbar to their
\ specification

Do Not check the Collapse all groups
box. This will cause messages to
disappear and it may look like there are
unread messages in the mailbox.




Contacts

In the address book the user can type individual addresses or a personal mail list.

When a mail list is named that name has priority over individual names already listed in the directory.

\

To create an individual’s
address, click this.

\

®00 \

Contacts : C;r;lpb;ﬁ County

To create a personal
mail list, click this

-

Go Back Go Forward

7

L. Contact Database

0 AAAAAAAAA
5] ABCRM Executive Boa
5] Advisory Board

New

New Contact
New Mail List

View by List Viey

New Contact Database

X

—_—

£ Amy Enzi New Message
[ Apple Support -
@ Arlene New Message Special
[ Barb Barlow
™ Barb Myers New Event
£ Beth New Task
1 ®0 0 New Contact : Campbell County =
H &8 X « » 0
Save and Close Print Attach | Delete | Previous Item NextItem Help
First name: Middle name: Last name: Title:
B
Job title: (© Department: Office:

Business

Business email:

[ Voice/Fax FEmaimJRL 1 Address ' Notes ' Attachments ]

Personal email:

Company web site:

Personal web site:

» Ifa list is made under a
By Index Card | Print Delete new contact only the
- first name on the list
gy Unlimited ]| receive the email.

el Use New Mail List for
@ a list of names grouped
(I) together.
#EN @
’ )
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The personal address can contain several important
facts about an individual.

Type in the name you wish to give the file in the
Name box and then fill in the information under the
different tabs.



The personal mail list is to be used for
several people that a user may send the
same message to such as a group to which
the user belongs.

Type in the name that you wish to call the
mail list in the Name box and then add the
member’s email address in the Members
box.

If a name is in the FirstClass system,
only the name of the member needs to be
entered not the whole email address.

o000 New Mail List

: Campbell County

7] Personal Mail List

| ————
Name: New Mail List . Cancel
Members: (oK \

e ————e




Calendar

Different ways to
view the calendars

Calendar : Campm

000 (@)
CEEEEEEEEETIE
Go Back Go Forward New Print Delete || Show Today List | Goto Today Day Work Week Week | Month Find Directory | Help
| |4 Calendar 628 Events 2 Tasks Campbell County : Cynthia Rigsby Unlimited @asf
i ‘ Today ' Calendars n n
! Tuesday Wednesday Thursday Friday Saturday
: 31 Aug 1 2
Today 9:00 Exec
Comm
[[12:00 Region Board Meeting [ |
k7 4 5 6 7 8 9
10 11 12 13 14 15 16
8:00 Tech
Training
1
»
17 18 19 20 21 22 23
3:30 Backup 8:00 check
Lexia hotmail
Servers account
24 25 26 27 28 29 30
44/ 4] Aug 2008 » [P
SMTWT F S
272820 301 2
3 4 56 7 8 9
10 11 12 13 14 15 16
17 18 19 20 21 22 23
24 25 26 27 28 29 30
311 2 3 45 6
54 | July 31, 2008 10:15 AM (GMT-7:00) Mountain Time 8 f
000 Event : Campbell County =
This calendar is in a split screen format. If you wish to H &8 E X0
. . . . Save and Cl Print Attach | Directs Delete Histe Helj
view one half differently, click anywhere on that side of — i it i i
. . . . ' Event ‘ Participants I Advanced ]
the screen and click on the view icon you desire. The
. You are invited to the following event by: ¢ Cynthia Rigsby
calendar can be viewed as a monthly calendar, a weekly
. . Description: [I J
calendar or a daily calendar. It can also be viewed as a ocaton
list of all events on the calendar. cegoy: 1) oo [ 9
Starts at: ( July 7, 2008 8:00 AM E‘ Duration: 1 Hour i:’
Ends at: [ July 7, 2008 9:00 AM =+ ] All day event
Showas: | Busy ¥
My reminders
() None
(@ Time before event: 30 Minutes A4
ocC|r B | | | |
Geneva lv! 14 lv! Wiv) [Left 5] [nsert.. %) [ Format...
| S VS W WS S W — e — ————— . |
125% = @ &




To add an event to the date, double click on that date and a window will open.

000

Event : Campbell County

0)

A reminder can also be set by
clicking on button under My

Save and Close Print

K 23

Attach | Directory

X

Delete History

®

Help

. . . Even ' Partici ' Advanced
Reminders and then setting the time [ Gent Ytamcoans ance |

1 Event date:
to have the reminder go off. ventigate

Event time (click to set start):

Next Free Time

( e
(4J( July 7, 2008 210K (@& )
9 1011 12 1 2 3 4 5 6
People Resources 1
Cynthia Rigsby ™
= Event &= Busy &= Conflict Tentative ZZ Can't see busy times ZZ Can'tinvite

OC|P B

GCeneva

iv] 14 iVJ .ivi" Left

f 3] [ Insert..

} 3] [ Format...

Click on the Participants Tab. In this area others can
be invited to participate in the event. If you enter their
name as a participant, an event will be put on their
calendar. If there is a conflict with that date or time of

any participants, you will receive an email informing
you of that conflict.

The user can set this event to repeat at certain intervals

by clicking on the Advanced tab. Click on the repeat
interval and set how often it should repeat, then click
on the Repeat Until and set a date to end the repeat.

[ G SN S SR S S S S S S SR S ) |
125% w2 5
—A
[8 00 Event : Campbell County -
B 2% E X0
—_— -
Save and Close Print Attach | Directory | Delete History Help
( Event T Participants ' Advanced ]
Repeat interval: | None =)
Repeat until: | None )
Time zone: | (GMT-7:00) Mountain Time ‘¢]
Visibility: This field controls which users can view this event
Icon: “:
Geneva W] 14 W] .‘vv] [Left 4] [Insert... %) (Format...
125% | [2) ]




Attaching and Saving Files

to an email

To attach a file to an email, open a new message. Click on file in the
menu bar and click on Attach. Find the file you wish to attach and
double click on it.

To save an attachment from a message, click once on the attachment
in the message, then go to File in the menu bar and click on Save
Attachment. Pick a file you wish to save to and click save.

New
Open
Close
Save As...

Attach...

Import
Export...

Delete

Get Info...

Print Layout
R

#EW

#®T
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